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Abstract 
 

Purpose 
Nature’s benefit mapping provides a way to quickly get an idea of where the beneficial aspects 
of ecosystems can be found. When trying to communicate the value of natural areas to policy 
makers, members of a community, or another group, it can help to provide an intuitive visual. 
Beyond just creating an attractive picture, though, nature’s benefit mapping also encourages 
thinking about how nature provides many of the things people need to thrive, and about ways 
that smart development can bolster the important benefits that nature provides. The value of 
natural areas can sometimes be pushed to the wayside in discussions about urban or suburban 
planning, and nature’s benefit mapping is a way of taking nature back into consideration.  

Objective 
To demonstrate a fast method of mapping nature’s benefits for use in communication and 
stakeholder engagement materials. While other techniques can be more precise and estimate 
benefits with greater certainty, they are often time-consuming, difficult, or rely on input data that 
is hard to find. The nature’s benefit mapping method places an emphasis on using public data, 
being accessible to anyone with basic geographic information system (GIS) competency, and 
being fast to apply. The resulting maps can be used to illustrate nature’s benefits to a non-
scientific or non-GIS audience. 

Requirements 
Before you use this guide, you should look at the eight example map handouts and read the 
Nature’s Benefit Mapping Information Sheet to familiarize yourself with nature’s benefit 
mapping. You will need the Original Shapefiles folder as well as the NatBenMap.tbx Arc 
Toolbox in order to go through this guide. All of these files are included in the Nature’s Benefits 
Package. This guide assumes that you have a copy of ArcGIS and basic familiarity with GIS 
software.  
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Executive Summary 
 

Nature’s benefits are the positive impact on people’s lives that they receive from ecosystems. Municipal planning 
decisions often include a cost-benefit analysis, but the benefits of nature are often left unconsidered. To engage 
decision makers and stakeholders in including nature’s benefits in planning decisions, it can be helpful to create a 
visual that indicates where nature’s benefits are provided. There are many ways to evaluate nature’s benefits, but 
some are complicated, take a long time, and require specialized expertise. The complex evaluation methods 
provide detailed information on the amount, location, and sometimes value of nature’s benefits. However, a 
detailed analysis is not always needed or desired. Our nature’s benefit mapping method is simple, fast, and can be 
done by a user with basic GIS expertise. We have produced eight nature’s benefit maps (bay scallops, hard clam 
collecting, shore caught fish, striped bass, summer flounder, viewing aquatic animals, vegetative wave attenuation, 
and yellow-crowned night herons) and example handouts for each to show how these maps can be used as 
communication tools.  

This guide provides step-by-step instructions that show how two of the nature’s benefit maps were created (hard 
clam collecting and shore based fishing), and instructions for editing the parameters of an existing map (yellow-
crowned night heron habitat). For more background on nature’s benefits, benefit mapping, and potential uses for 
benefit maps, please read the Nature’s Benefit Mapping Information Sheet that is included in the Nature’s Benefits 
Package. Also included are the eight example map files, the original shapefiles that were used to make them, and 
an Arc Toolbox containing the models that generated the maps. You will need Esri’s ArcGIS software, the original 
shapefiles, and the Arc Toolbox to use this guide.   
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Creating nature’s benefit maps in Arc ModelBuilder 
Creating nature’s benefit maps is based on constructing and applying map rules. These will transform our indicator 
datasets into the resulting nature’s benefit map we want. For example, a map rule we will use in making the hard 
clam gathering benefit map is “show areas with water depth less than 2 meters”.  

Example 1: Hard Clam Collecting 

1. Import the hard clam collecting indicator data, NWI_Rasterized.tif and CoNED_Resampled_Raster.tif, 
from the Original Indicator Files folder in the Nature’s Benefits Package into ArcGIS by clicking and 
dragging them from the Catalog. Note that for large datasets like the CoNED elevation map, we have 
already used Extract by Mask (Spatial Analyst Tools>Extraction) along with a study-area-shaped 
polygon to clip them to the size of our study area. Files that end with the suffix ‘_Rasterized’, have 
had a To Raster (Conversion Tools) tool applied. More detail on how to apply these can be found in 
the tool help files. If later on you are unsure which indicators to import for editing a particular map, 
just import all of the ones included in the Original Indicator Files section of the Nature’s Benefits 
package. You can remove the ones you don’t use later.  

 

 
2. Open a new Arc ModelBuilder model by going to ArcMap’s top toolbar and clicking Geoprocessing > 

ModelBuilder.  
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 An empty Model window will appear on the screen.  
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3. For the model to work well when shared between people using different computers, it is important to 
set the workspace which indicates where the model’s files will be saved.  

i. Click on Insert in the top row of the Model window, and then click Create Variable.  

 

ii. In the Create Variable window, scroll down to Workspace, select it by clicking on it, and then 
click OK.  
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iii. A white oval will appear labeled Workspace. Double click it.  

 

iv. In the dialog window that appears, click the small folder icon next to the text box. This will 
open a file browser window.  
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v. A file browser window will open. Navigate to the Nature’s Benefits Package folder in the 
location that you unzipped it on your computer, and then select the ModelBuilder Results 
folder as the workspace. Click Add and OK.  

 

vi. Now we need to mark this workspace oval as a Parameter, which tells people you share the 
tool with that it’s something they’ll need to change when they use the tool for the first time. 
To do so, right-click the blue ModelBuilder Results oval, and then click Model Parameter. A 
small “P” will appear near the ModelBuilder Results oval.  
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4. Click and drag the two indicator files from the Table of Contents, and place them in the Model 
window. They will appear as blue ovals.  

 

5. Now it’s time to apply a map rule. Our initial example was that we wanted to show areas that have a 
depth less than 2 meters. To extract areas of our CoNED depth file that are less than 2 meters deep, 
we will use the Extract by Attributes (Spatial Analyst Tools>Extraction) tool.  

i. Open the ArcToolbox window by clicking Geoprocessing > ArcToolbox in the top bar.  

 

ii. Click the “+” next to the Spatial Analyst toolbox, then the one next to Extraction, in order to 
bring up the Extract tools. These are used to clip out parts of a raster. 
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iii. Click and drag the Extract by Attributes tool into the Model window. It will appear as a white 
rectangle with rounded corners, and will be connected by an arrow to a white oval called 
“Output raster”. This lets you know what kind of output it is going to create.  
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iv. Double-click the Extract by Attributes rectangle. A dialog box will appear that asks for an 
input raster, a “WHERE” clause, and asks you to name the output raster.  

 

v. Click the drop-down arrow under input raster, and select “CoNED_Resampled_Raster.tif”. 
This is our elevation raster. Choose the one with the blue recycling symbol next to it, which 
tells ModelBuilder to use the version of the raster that we placed in the model earlier, in its 
blue oval.  
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vi. Under “WHERE clause”, we are going to have to use a little bit of SQL, or Structured Query 
Language. Luckily, we don’t have to know anything about SQL going in, because ArcGIS has a 
helper function and a help file to guide us. By clicking the small button labeled “SQL”, the 
Query Builder window opens.  

 

vii. Since we want to extract the areas where the depth is less than 2 meters, we can use the 
SQL expression, “VALUE < 0 AND VALUE > -2”. This translates to “Pixels in the raster with 
elevation less than zero (e.g. below sea level), but higher than negative 2 meters (e.g. water 
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2 meters deep)”. Once we type our SQL expression in, we click OK to return to the Extract by 
Attributes window.  

 

viii. Now we have to save our output raster and give it a name. First, since we already defined 
our workspace, rather than a filepath in the Output raster box we can just type 
%ModelBuilder Results%. This will save the file in the correct folder on anyone’s computer 
since they defined the %ModelBuilder Results% parameter to point to the location of their 
workspace folder in Step 3. We will call our output “CoNED_LessThan2Deep.tif”. Afterward, 
we can click OK and return to the Model window.  
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ix. Now we can see that we have completed applying a map rule, since our 
CoNED_Resampled_Raster.tif blue oval is connected to the Extract by Attributes rectangle, 
which has turned orange now that it is active. The Output Raster oval, which was empty 
before, is now green and has the name of our new output in it.  

 

6. Time to apply our second map rule, which is extracting all areas of the National Wetlands Inventory 
that have sand bottom type.  

i. First, apply Steps 5i – 5v. This means adding another Extract by Attributes tool rectangle but 
this time selecting NWI_Rasterized.tif as the input raster. 

 

ii. Under the “WHERE clause”, this time will be a little more in-depth. Refer to Figure A1 in the 
Appendix, the NWI Wetlands and Deepwater Map Code Diagram. Following the diagram, the 
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codes for the circled sand bottom type areas are ‘M1UB2’, ‘M2US2’, ‘E1UB2’, and ‘E2US2’. 
Therefore, we want to set our WHERE clause to pick out those values.  

iii. This raster stores the bottom type in a variable called ATTRIBUTE. If we want to know all the 
different values of ATTRIBUTE, we can highlight it by clicking on it in the top window, and 
then clicking Get Unique Values. 
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iv. Using the Help file to figure out the right SQL operator, “IN”, we specify that we want the 
pixels where ATTRIBUTE is equal to the codes for sand bottom, and place that in the Query 
window. Note that not all the codes we originally were going to use were found in the area, 
and some had suffixes that indicate more specific information based on the NWI diagram. 
We included all the suffixes since they all represent sand bottom type.  

 

v. Name your output raster and click OK. We chose “NWI_ClamBottom.tif”. Now you have two 
completed map rules. The next step is to combine the two results into an area where both 
map rules are true, i.e. where clams can be collected.  
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7. The final step is to combine the areas where the water is less than 2 meters deep and the areas 
where there is sand bottom type, to come up with a map of the areas where both our indicators are 
true. 

i. The tool we are going to use to merge the two indicator raster files is called Raster 
Calculator (Spatial Analyst Tools>Map Algebra). Open ArcToolbox, click the “+” next to 
Spatial Analyst Tools, and then again next to Map Algebra. Then click and drag Raster 
Calculator into the model window, creating a new empty rectangle.  

 

 

ii. Double-click the Raster Calculator rectangle to bring up the Map Algebra expression 
window.  
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iii. We can see that the Raster Calculator uses Python syntax to perform math operations on 
rasters. In this case we want to figure out what the Python syntax is to give us a result that 
includes all areas where the depth is less than 2 meters, and the bottom type is suitable for 
clams. We won’t get into Python in this guide, but the Tool Help button provides instructions 
and there are many simple guides online. Enter the proper command into the Raster 
Calculator window.  

 

iv. Name your result file and click OK. Since this is the last step before we’ll be left with our final 
map of clam areas, we have named our results HardClam_Areas.tif. You’ll return to the 
Model window and have a complete ModelBuilder diagram. Go ahead and save your model 
by clicking the save icon in the upper left corner.  
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8. Finally, it’s time to run the model and see your results! To run the model, click Model in the top 
toolbar and navigate down to Run Entire Model. Click it and watch your model run. Each orange 
rectangle will turn red while it’s running and there will be a status window that shows each step’s 
progress.  
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9. Now, navigate to the ModelBuilder Results folder where you saved the resulting Hard Clam Areas 
raster and add it to your map. It’s still multicolored like the NWI wetlands map. This is because of the 
way Raster Calculator works: the result raster contains information from all of the ingredients it was 
made from. We will need to change the symbology to make the clam areas all the same color (unless 
we are actually interested in the different bottom types from NWI, but in this case we want to treat 
them all the same).   

 

i. There are many ways to change the display colors, but here is one example. To change the 
symbology so that the areas all display the same color, right-click the shapefile in the Table 
of Contents and click Properties.  
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ii. When the Layer Properties window opens, select the Symbology tab.  

 

iii. Double click the colored rectangle next to each value label, and change it to whatever color 
you like. We will use Moorea Blue.  
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iv. Repeat with all the values until they are the same color, then click Apply followed by OK. As 
an alternative, you can select one of the values, right-click, select “Properties for all 
Colors…”, and then change them all at once. 

 

v. Now all the areas are Moorea Blue, but this doesn’t mean much without being able to see 
the borders of the bay. We will add a shoreline for reference next.  
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10. In the Catalog window, navigate to the NOAA composite shoreline polygon file, 
Hempstead_PolygonShoreline.shp (See Figure A2, Appendix), and add it to the map. Now we have a 
frame of reference to see how close the clam areas are to the coast. Now we have the final nature’s 
benefit map of clam areas. You can add place names, a compass rose, a scale bar, or whatever else is 
needed for your particular use. You can save an instance of this workspace, with all the current maps 
imported, by clicking File > Save As in the top bar.  

 

 

  



   

25 
 

Example 2: Shore-based Fishing 

1. After you save your hard clam collecting map, open a new ArcGIS workspace instance by clicking File 
> New in the top bar. Then click and drag in the indicator datasets, PublicParks_ShoreOnly.shp and 
Hempstead_PolygonShoreline.shp, from the Catalog as before.  

 

2. Create a Workspace variable and set it to the ModelBuilder Results folder as in example 1, step 3.  
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3. Open a new ModelBuilder window, and click and drag both of the shapefiles into the model. They will 
appear as blue ovals.  

 

4. Now we will start applying our map rules. Let’s think about what kind of tools we may need to use, 
since our goal is to extract the parts of the shoreline that are within 30 meters of a public accessible 
park. First, we need to turn our shoreline polygon into a polyline file, then break the shoreline into 
small pieces so we can clip parts out of it.  

i. To turn a polygon’s outline into a polyline, we use Feature to Line (Data Management Tools 
> Features). Grab the tool in ArcToolbox and drag it into the Model window.  

 

ii. Next, double-click on the Feature to Line rectangle and insert the shoreline file as the input 
feature. Make sure to use the one with a blue recycling symbol in front of it as in the earlier 
clam example, which will automatically attach the blue oval to the tool rectangle. Name the 
output whatever you like, remembering to use %ModelBuilder Results% instead of a filepath 
to save in the workspace. We will call it Hempstead_Polyline.shp.  
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iii. When we select the parts of the shoreline that are suitable for shore fishing, we are going to 
have to make sure the program knows we only want it to select part of the shore, not the 
whole thing. There are several ways to cut out parts of a line in ArcGIS, but the way we 
chose is to split the shoreline file into many very small line segments. We chose the Split Line 
at Vertices (Data Management Tools > Features) tool because it works well with lines that 
are very convoluted, like a shoreline. Grab that tool and drag it into the Model window.  

 

 

iv. Double-click the Split Line At Vertices rectangle, and add the Hempstead_Polyline as the 
input file. We named the output Hempstead_Polyline_Split.shp. When you’re done it should 
look like this in your model window.  
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v. Now we will select the parts of the shoreline that are within 30 feet of our parks. To do so, 
we will use Select Layer by Location (Data Management Tools > Layers and Table Views). 
Grab this tool and drag it into the Model window, then double-click on it. You’ll end up with 
this tool window.  

 

 

vi. We want to set our Input Feature Layer Hempstead_Polyline_Split, but when we click the 
dropdown arrow it isn’t listed! Like usual, the answer is in the help pane to the right. We see 
that the input can’t be a feature class on disk. That means we have to already have the file in 
our workspace. We can do that by running the model we have so far.  
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vii. Select the portion of the model Hempstead_PolygonShoreline.shp to 
Hempstead_Polyline_Split, by either shift-clicking each one or by clicking and dragging the 
selection box around each. Blue boxes will appear around them to indicate that they’re 
selected.  

 

 

viii. With the top row selected, click Model > Run in the top bar. This will run the selected 
operations and create Hempstead_Polyline_Split.shp.  
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ix. Now, you’ll be able to find Hempstead_Polyline_Split.shp wherever you specified it to save 
when setting up Split Line At Vertices. Navigate to it in the Catalog and drag it into the main 
window, where it will show up in the Table of Contents and be displayed over your shoreline 
polygon. It will show up as a thin border line around the polygon shoreline.  

 

 

 

x. Double-click Select Layer By Location again, and this time we can put 
Hempstead_Polyline_Split.shp as the Input Feature. Now we want to select parts of the 
shoreline that are within 30 meters of the public parks, so we click the dropdown box under 
Relationship, and select WITHIN_A_DISTANCE_GEODESIC. Remember, if you are unsure 
what something does in the tool window, help will be in the pane to the right.  
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xi. Next, set the Selecting Features to PublicParks_ShoreOnly. Like the help pane says, parts of 
the Input Feature Layer will be selected based on their relationship to the Selecting Features.  

 

xii. We want to select parts of the shore that are within 30 meters of our parks. Type 30 into the 
Search Distance box, then select Meters from the dropdown next to it.  
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xiii. We want to create a new map layer from the selected parts of the shoreline, so we can leave 
Selection Type as NEW_SELECTION. We don’t want an inverse relationship, so leave that box 
unchecked. Finally, click OK. A new blue oval has appeared, with 
Hempstead_Polyline_Split.shp in it. Place it wherever you like in the diagram by clicking and 
dragging. There’s also a green oval labeled Hempstead_Polyline_Split (2) as the output from 
Select Layer By Location. This represents the selected parts of the shoreline after the tool is 
executed.  

 

xiv. Now we need to save the selected parts of the shoreline as their own separate shapefile so 
we don’t have to run the model every time we want to see them. To save a selection as its 
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own file, use Copy Features (Data Management Tools> Features). Click and drag it from 
ArcToolbox into the model window.  

 

xv. Double-click the Copy Features rectangle and add the selected features from the shoreline as 
the Input Features. This part can be tricky, since there are multiple files with the name 
Hempstead_Polyline_Split in our workspace, but in this case we pick the one that has a 
number in parentheses after it. That means it’s the most recently added one.  

 

xvi. Now set the Output Feature Class to wherever you want it to be saved, and click OK. Don’t 
worry about the other options in Copy Features, they only apply in special cases. We called 
our output file ShoreFishing.shp. 



   

34 
 

 

xvii. Now since we have already run the top row of the model to get the split polyline, all that 
remains is to run the bottom row of the model. Select the bottom row of the model by 
drawing a box around it as in Step 4.vii, click Model > Run, and watch it complete. 
Congratulations, we now have the areas of shoreline that are accessible to fishermen within 
30 meters of parks! 
 

5. Now we can display our publicly accessible fishing shore on the map. Navigate to wherever you saved 
it in the Copy Features output, and drag it into the Table of Contents after clearing it of other files.  
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6. For reference, add back in the Hempstead_PolygonShoreline, so we can see which parts of the 
shoreline are not accessible for reference. We can see that our publicly accessible fishing shoreline 
doesn’t show up very well since the line is so thin, and the red color doesn’t match with our earlier 
Moorea Blue. We’ll want to change it to show up better.  

 

7. To make our publicly accessible fishing points show up better, click the small red line under the name 
of the shapefile in the Table of Contents. From there, click the dropdown box next to Color and 
switch it to Moorea Blue.  
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8. Change the width by either clicking on the up arrow in the box next to Width, or by typing a number 
into the box. The resulting color and width will be previewed where it says Current Symbol. We chose 
3 as a nice width that will show up well.  

 

9. Click OK and take a look at your nature’s benefit map of publicly accessible fishing shores. You can 
add a scale bar, compass rose, town names, or anything else you need later depending on what you 
will use the map for.  
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3. Editing nature’s benefit maps in Arc ModelBuilder 

A nature’s benefit map is only as good as its indicators and map rules. If you want to update a map after getting 
new information or data, there’s no need to recreate the ModelBuilder tool. You can simply change the rules to 
edit your map. We’ll go through a simple example with the habitat areas of yellow-crowned night herons. For 
reference, the indicators for yellow-crowned night heron habitat were areas of woody wetland that are within 50 
meters (about 150 feet) of emergent wetlands. We chose those indicators because the birds like to nest in trees 
that overlook the emergent wetlands where they feed. Their habitat is considered a nature’s benefit because they 
are a rare species that is enjoyed by birdwatchers and conservationists.  

In our example, we are going to decide that yellow-crowned night herons have a longer tolerance for emergent 
wetland distance than we originally thought, and will live within 100 meters (about 300 feet) of an emergent 
wetland.  

1. For reference, here is the current nature’s benefit map of yellow-crowned night heron habitat with 
the 50 meter map rule applied. 
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2. Open a new instance of ArcMap. Then open the existing yellow-crowned night heron ModelBuilder 
model. In ArcCatalog, navigate to the toolbox file (NatBenMap.tbx) that contains the ModelBuilder 
model and right-click it. Then, select Edit. 
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3. Once you click Edit, the model window will appear with the current diagram for the yellow-crowned 
night heron habitat map rules. First, double-click the ModelBuilder Results oval in the top left, and set 
the workspace to the location of the ModelBuilder Results folder in the Nature’s Benefits Package on 
your computer. 

 

4. Note that the model requires ncld2011_clip as initial input in order to run. Initial inputs will always be 
blue ovals that are at the beginning of the flowchart. Since we are editing and then re-running this 
model, we need to put ncld2011_clip into the Table of Contents by dragging it into the mapping area 
from the Original Indicator Files folder in the Nature’s Benefits Package.  
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5. The way this model works is that we extract the areas that correspond to woody wetlands, then 
extract the areas that correspond to emergent wetlands. Those emergent wetlands get converted to 
polygons and have a distance buffer applied to them, which represents the distance at which woody 
wetland habitat is considered suitable for a yellow-crowned night heron to nest. In this case, we want 
to edit the Buffer step, which adds on the 50 meter buffer zone. Double-click the Buffer rectangle.  

 

6. Note that the Distance is marked as 50 meters, and that the output feature class file is called 
NCLD_EmergentWetlands_Buffered50m.shp. Since we want to change the buffer to 100 meters, 
change the Distance box to read 100 meters, and change the output filename to 
NCLD_EmergentWetlands_Buffered100m.shp. You can leave the %ModelBuilder Results% part the 
same, because you set the workspace to the folder’s location on your computer in Step 3.
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7. Note that the green circle coming from Buffer now reads NCLD_EmergentWetlandsBuffered100.shp, 
but it still leads to Extract by Mask after it. ModelBuilder automatically updates the file path for the 
inputs of subsequent steps if you change a previous one.  

 

8. Now, we want to change the file output of Extract by Mask so that it won’t overwrite our previous 
yellow-crowned night heron habitat file. We want both so that we can compare them. Double-click 
on Extract by Mask and change the output file to YellowCrowned_NightHerons100.tif. Change the 
path to wherever you want it to be saved, then click OK. Again, leave %ModelBuilder Results% the 
same, since it’s a pointer to the workspace location. 
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9. Finally, run the model again and add the new output, YellowCrowned_NightHerons100.tif, to the 
map. Change its color to something that contrasts with the old 50 meter nature’s benefit map, so that 
we can see the difference that our edited map rule has made. We added a legend square to this map, 
and the additional habitat areas marked by the new map rules are in red.  
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Appendix: Choosing your indicators 
 

An indicator is a concept borrowed from ecology, where it is a habitat characteristic that coincides with the 
presence of an animal or plant species. In this case, we define an indicator as a characteristic that can be plotted 
on a map that we think coincides with the presence of our benefit. To map places where one can gather hard 
clams, first think about what would indicate the presence of that benefit. People can only reach so far under the 
water, even if they are using a specialized scooping tool to collect clams. One of our indicators will be water depth 
less than 2 meters (about 6 feet) at mean tide, which will represent the area where a collector could reasonably 
reach the bottom of the bay at low tide. The next indicator will represent areas that hard clams are likely to live. To 
choose this indicator, we looked at the ecology of the hard clam and found that they tend to live in areas that have 
a sand bottom type. Therefore, our indicators for hard clam collecting will be areas of the bay with a sand bottom 
that are 2 meters or less deep at mean tide, since that is where hard clams that people can reach live. It’s 
important to note here that only the clams people can get to are considered a nature’s benefit: if people can’t get 
them, then they don’t count. Because of this, most nature’s benefit maps will include at least one indicator of 
accessibility.  

 For shore-based fishing, we want to think about what indicates the ability for a member of the public to catch fish 
while standing on the shore. First, and most obviously, the area has to be next to the water, since an angler needs 
to be on the shore to shore fish. The first indicator will be areas that are on the shoreline. Since a benefit doesn’t 
count if people can’t access it, we then need to find areas that members of the public are allowed to access. Our 
second indicator for shore-based fishing is public accessibility, for example areas in state or local parks. Finally, an 
angler can reasonably cast a line about 30 meters (around 90 feet) at the most, so our areas can’t be more than 30 
meters away from the publicly-accessible areas of shore. Putting all three of our indicators together, areas that 
provide the benefit of shore-based fishing are parts of the shoreline that are within 30 meters of a public access 
point like a park.  

Finding your indicators 
Once indicators are chosen, the next step is to find spatial data on the indicator and get it into ArcGIS for mapping. 
Indicators can be in almost any geographical information format, from elevation rasters to viewshed maps. One 
thing they have in common is that they can be plotted in a GIS program. In all eight of the examples provided with 
the nature’s benefit mapping zip file, publicly available indicator data was used; there is usually no need to get 
proprietary or privileged information. If an indicator is not easily found or is behind a pay wall, it might be better to 
choose a different one. 
 
In the example of hard clam gathering, our first indicator was an indicator of accessibility: water depth less than 2 
meters at mean tide. A raster or elevation map showing water depth of tidal zones is the indicator data that we 
need, and by looking online we can find the Coastal National Elevation Database Project 
(https://lta.cr.usgs.gov/coned_tbdem), operated by the United States Geological Survey. The site contains a free 
download link for the Topobathymetric Digital Elevation Model, which shows the depth of coastal U.S. waters. We 
note that there is a special report on the site that details how the topography and bathymetry model was adjusted 
after Hurricane Sandy (https://pubs.usgs.gov/fs/2013/3090/), which settles concerns we might have about 
outdated indicator data. The second indicator is sand bottom type. To get data on substrates on the bay bottom, 
we search online and find the United States Fish and Wildlife Service National Wetlands Inventory 
(https://www.fws.gov/wetlands/nwi/index.html). This dataset, also freely available for download, contains 
information about wetland and estuarine types for the coastal United States. We check the Wetlands and 
Deepwater Code Diagram on the website 
(https://www.fws.gov/wetlands/documents/NWI_Wetlands_and_Deepwater_Map_Code_Diagram.pdf) to see if it 
provides data on the bottom substrate of estuaries and bays (Figure A1).   

https://lta.cr.usgs.gov/coned_tbdem
https://pubs.usgs.gov/fs/2013/3090/
https://www.fws.gov/wetlands/nwi/index.html
https://www.fws.gov/wetlands/documents/NWI_Wetlands_and_Deepwater_Map_Code_Diagram.pdf
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Figure A1. The National Wetlands Inventory contains the bottom type indicator we are looking for.  
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For shore-based fishing, obtaining some of the indicators was a little more difficult. For the shoreline data, we did 
an internet search for “United States shoreline polygons” and were directed to the National Oceanic and 
Atmospheric Administration (NOAA) Office for Coastal Management Shoreline Website 
https://shoreline.noaa.gov/). On the front page, there is a link to “Download Shoreline Data” with several options 
(Figure A2). After evaluating each shoreline product, we decided to download the NOAA Composite Shoreline, 
which the site says is for high-resolution cartographic work. We then clipped it using an Area_Rectangle shape so it 
would only reflect the south Hempstead bay area. The shapefile was then converted to a polygon. Note: our 
shoreline shapefile was edited in many areas because it was been also used for another project, but this is not 
necessary to create the benefits map. 
 

 

Figure A2. The NOAA Shoreline site has several options for shoreline datasets. 

 

The second indicator, publicly-accessible areas, wasn’t available as a free dataset online despite our searching. 
Therefore, we decided to create it ourselves from data we had. We opened the ESRI World Topographic Map that 
comes with an ArcGIS Online subscription, and then traced over the locations of all the areas labeled as public 
parks or beaches along the shore using the Editor tool to create a new polygon file (Figure A3). It should be noted 
that unlike the other indicator data we have obtained so far, these data are not from a U.S. Government public 
source. Even though we aren’t really using the original map, and are just using it to make a new polygon file of our 
own, it is still a good idea to examine the type of license you have thoroughly to ensure you are using the map 
properly, and to credit the original source on any documents you produce as we have done on our Shore-Based 
Fishing handout.  

The third indicator for shore-based fishing was that we would also include any area of shoreline within 30 meters 
of our publicly-accessible points, because an angler standing on the shore can cast a bait about that far. We will 
used tools within ArcGIS ModelBuilder later on to ensure that our resulting map includes areas of the shore that 
are within 30 meters, so there is no need to download another indicator dataset.  

 

https://shoreline.noaa.gov/
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Figure A3. Since we couldn’t find a public park file, we created our own.  
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